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Rechtliche Hinweise
Die Marke Schneider Electric sowie alle anderen in diesem Handbuch enthaltenen
Markenzeichen von Schneider Electric SE und seinen Tochtergesellschaften sind das
Eigentum von Schneider Electric SE oder seinen Tochtergesellschaften. Alle anderen
Marken können Markenzeichen ihrer jeweiligen Eigentümer sein. Dieses Handbuch
und seine Inhalte sind durch geltende Urheberrechtsgesetze geschützt und werden
ausschließlich zu Informationszwecken bereitgestellt. Ohne die vorherige schriftliche
Genehmigung von Schneider Electric darf kein Teil dieses Handbuchs in irgendeiner
Form oder auf irgendeine Weise (elektronisch, mechanisch, durch Fotokopieren,
Aufzeichnen oder anderweitig) zu irgendeinem Zweck vervielfältigt oder übertragen
werden.

Schneider Electric gewährt keine Rechte oder Lizenzen für die kommerzielle Nutzung
des Handbuchs oder seiner Inhalte, ausgenommen der nicht exklusiven und
persönlichen Lizenz, die Website und ihre Inhalte in ihrer aktuellen Form zurate zu
ziehen.

Produkte und Geräte von Schneider Electric dürfen nur von Fachpersonal installiert,
betrieben, instand gesetzt und gewartet werden.

Da sich Standards, Spezifikationen und Konstruktionen von Zeit zu Zeit ändern,
können die in diesem Handbuch enthaltenen Informationen ohne vorherige
Ankündigung geändert werden.

Soweit nach geltendem Recht zulässig, übernehmen Schneider Electric und seine
Tochtergesellschaften keine Verantwortung oder Haftung für Fehler oder
Auslassungen im Informationsgehalt dieses Dokuments oder für Folgen, die aus oder
infolge der Verwendung der hierin enthaltenen Informationen entstehen.
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Sicherheitshinweise

Wichtige Informationen
Lesen Sie die Anweisungen sorgfältig durch und sehen Sie sich die Ausrüstung
genau an, um sich mit dem Gerät vor der Installation, dem Betrieb oder der
Wartung vertraut zu machen. In diesen Unterlagen oder auf dem Gerät können
sich folgende Hinweise befinden, die vor potenziellen Gefahren warnen oder die
Aufmerksamkeit auf Informationen lenken, die ein Verfahren erklären oder
vereinfachen.

Bitte beachten

Elektrisches Gerät sollte stets von qualifiziertem Personal installiert, betrieben und
gewartet werden. Schneider Electric übernimmt keine Verantwortung für jegliche
Konsequenzen, die sich aus der Verwendung dieser Publikation ergeben können.

Eine qualifizierte Person ist jemand, der über entsprechende Fertigkeiten und
Kenntnisse zu Aufbau und Betrieb von elektrischen Geräten sowie zu deren
Installation verfügt und eine entsprechende Sicherheitsschulung zur Erkennung
und Vermeidung der damit verbundenen Gefahren absolviert hat.

Wird dieses Symbol zusätzlich zu einem Sicherheitshinweis des Typs „Gefahr“ oder 
„Warnung“ angezeigt, bedeutet das, dass die Gefahr eines elektrischen Schlags 
besteht und die Nichtbeachtung der Anweisungen unweigerlich Verletzung zur Folge 
hat.

Dies ist ein allgemeines Warnsymbol. Es macht Sie auf mögliche Verletzungsgefahren 
aufmerksam. Beachten Sie alle unter diesem Symbol aufgeführten Hinweise, um 
Verletzungen oder Unfälle mit Todesfälle zu vermeiden.      

GEFAHR macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht vermieden 
wird, Tod oder schwere Verletzungen zur Folge hat.

! GEFAHR

WARNUNG macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht vermieden 
wird, Tod oder schwere Verletzungen zur Folge haben kann.

WARNUNG!

VORSICHT macht auf eine gefährliche Situation aufmerksam, die, wenn sie nicht vermieden 
wird, leichte Verletzungen zur Folge haben kann.

VORSICHT!

HINWEIS gibt Auskunft über Vorgehensweisen, bei denen keine Verletzungen drohen.

HINWEIS

DOCA0236DE-00 5



TeSys island – Digitale Motormanagement-Lösung Zu diesem Dokument

Zu diesem Dokument

Geltungsbereich des Dokuments
Dieses Dokument enthält die Schritte, die erforderlich sind, um in der
EcoStruxure™ Control Expert Classic-Software ein Projekt mit einem TeSys™

island und einem Logik-/Motion-Controller mithilfe des Modbus TCP-Protokolls zu
erstellen.

In diesem Dokument sind außerdem Angaben zu Folgendem zu finden:
• Integration von TeSys island in das EcoStruxure Control Expert Classic-

Projekt
• Zugriff auf den TeSys island-DTM (Device Type Manager) über die

EcoStruxure Control Expert Classic-Software zur Konfiguration der TeSys
island-Module und -Verfahren mithilfe von TeSys-Avatars.

• Verwendung der Funktionsblöcke der TeSys island-Bibliothek, die in der
EcoStruxure Control Expert Classic-Software zur Entwicklung von
Anwendungen und zur Steuerung von TeSys-Avatar-Modulen verfügbar ist.

Es wird empfohlen, dass ein Benutzer, der dieses Dokument verwenden möchte,
mit Folgendem vertraut ist:

• Informationen zur Funktionsweise, Struktur und Konfiguration des TeSys
island

• Informationen zur Funktionsweise, Struktur und Konfiguration des Controllers

Gültigkeit
Diese Anleitung bezieht sich nur auf:

• Software EcoStruxure Control Expert Classic v15.0 SP1 – Classic
• SPS Modicon M580

Online-Informationen
Die in dieser Anleitung enthaltenen Informationen können jederzeit aktualisiert
werden. Schneider Electric empfiehlt nachdrücklich die Verwendung der neuesten
und aktuellsten Version, die unter www.se.com/ww/en/download/ erhältlich ist.

Die technischen Merkmale der Geräte, die im vorliegenden Dokument
beschrieben werden, sind auch online verfügbar. Um diese Informationen online
einzusehen, rufen Sie die Schneider Electric-Homepage auf.

Zugehörige Dokumente

Titel des Dokuments Referenznummer
TeSys island – Systemanleitung 8536IB1901DE

TeSys island DTM-Bibliothek Online-Hilfe Erhältlich mit dem
Installationsprogramm

Modicon M580 – Hardware-Referenzhandbuch EIO0000001578

EcoStruxure Control Expert – TeSys island-Bibliothekssteuerung
Benutzerhandbuch

EIO0000004519
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Aus Normen abgeleitete Terminologie
Die technischen Begriffe, die Terminologie, die Symbole und die entsprechenden
Beschreibungen in dieser Anleitung bzw. in oder auf den eigentlichen Produkten,
sind im Allgemeinen von den Begriffen und Definitionen der internationalen
Normen hergeleitet.

Im Bereich der funktionalen Sicherheitssysteme, Antriebe und allgemeinen
Automatisierungssysteme betrifft dies u. a. Begriffe wie „Sicherheit“,
„Sicherheitsfunktion“, „sicherer Zustand“, „Störung“, „Fehlerreset“, „Fehlfunktion“,
„Ausfall“, „Fehler“, „Fehlermeldung“, „gefährlich“ usw.

Zu den betreffenden Normen zählen folgende:

Standard Beschreibung

IEC 61131-2:2007 Speicherprogrammierbare Steuerungen – Teil 2: Betriebsmittelanforderungen und
Prüfungen

ISO 13849-1:2015 Sicherheit von Maschinen – Sicherheitsbezogene Teile von Steuerungen

Allgemeine Gestaltungsleitsätze

EN 61496-1:2013 Sicherheit von Maschinen – Berührungslos wirkende Schutzeinrichtungen

Teil 1: Allgemeine Anforderungen und Prüfungen

ISO 12100:2010 Sicherheit von Maschinen – Allgemeine Gestaltungsleitsätze – Risikobeurteilung
und Risikominderung

EN 60204-1:2006 Sicherheit von Maschinen – Elektrische Ausrüstung von Maschinen – Teil 1:
Allgemeine Anforderungen

ISO 14119:2013 Sicherheit von Maschinen – Verriegelungseinrichtungen in Verbindung mit
trennenden Schutzeinrichtungen – Leitsätze für Gestaltung und Auswahl

ISO 13850:2015 Sicherheit von Maschinen – Not-Halt-Funktion – Gestaltungsleitsätze

IEC 62061:2015 Sicherheit von Maschinen – Funktionale Sicherheit sicherheitsbezogener
elektrischer, elektronischer und programmierbarer elektronischer
Steuerungssysteme

IEC 61508-1:2010 Funktionale Sicherheit sicherheitsbezogener elektrischer/elektronischer/
programmierbarer elektronischer Systeme: Allgemeine Anforderungen

IEC 61508-2:2010 Funktionale Sicherheit sicherheitsbezogener elektrischer/elektronischer/
programmierbarer elektronischer Systeme: Anforderungen an sicherheitsbezogene
elektrische/elektronische/programmierbare elektronische Systeme

IEC 61508-3:2010 Funktionale Sicherheit sicherheitsbezogener elektrischer/elektronischer/
programmierbarer elektronischer Systeme: Softwareanforderungen

IEC 61784-3:2016 Industrielle Kommunikationsnetze – Profile – Teil 3: Funktional sichere Übertragung
bei Feldbussen – Allgemeine Regeln und Festlegungen für Profile

2006/42/EG Maschinenrichtlinie

2014/30/EU Richtlinie zur elektromagnetischen Verträglichkeit (EMV-Richtlinie)

2014/35/EU Niederspannungsrichtlinie

Zusätzlich kann die im vorliegenden Dokument genutzte Nomenklatur auch aus
anderen Normen stammen, wie z. B.:
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Standard Beschreibung

Normenreihe IEC
60034

Drehende elektrische Maschinen

Normenreihe IEC
61800

Elektrische Leistungsantriebssysteme mit einstellbarer Drehzahl

Normenreihe IEC 61158 Digitale Datenkommunikation in der Leittechnik – Feldbus für industrielle
Leitsysteme

Wenn der Begriff „Betriebsbereich“ in Verbindung mit der Beschreibung
bestimmter Gefahren verwendet wird, entspricht er der Definition von
„Gefahrenbereich“ oder „Gefahrenzone“ in der Maschinenrichtlinie (2006/42/EG)
sowie in der Norm ISO 12100:2010.

HINWEIS: Die zuvor erwähnten Normen können auf die spezifischen
Produkte im vorliegenden Dokument zutreffen oder nicht. Weitere
Informationen zu den einzelnen Normen, die auf die hier beschriebenen
Produkte anwendbar sind, finden Sie in den entsprechenden Datentabellen
der bezeichneten Produkte.

Produktinformationen

WARNUNG
STEUERUNGSAUSFALL
• Bei der Konzeption von Steuerungsplänen müssen mögliche Störungen auf

den Steuerungspfaden berücksichtigt werden. Außerdem muss bei
bestimmten kritischen Steuerungsfunktionen gewährleistet sein, dass
während und nach einem Pfadfehler ein sicherer Zustand erreicht wird.
Beispiele für kritische Steuerungsfunktionen sind Notabschaltung (Not-Aus)
und Nachlauf-Stopp, Stromausfall und Neustart.

• Für kritische Steuerungsfunktionen müssen separate oder redundante
Steuerungspfade bereitgestellt werden.

• Systemsteuerungspfade können auch Kommunikationsverbindungen
umfassen. Dabei müssen die Auswirkungen unerwarteter
Sendeverzögerungen oder Verbindungsstörungen berücksichtigt werden.

• Sämtliche Unfallverhütungsvorschriften und lokale Sicherheitsrichtlinien sind
zu beachten.1

• Jede Implementierung dieses Geräts muss vor seiner Inbetriebnahme
separat und gründlich auf ordnungsgemäßen Betrieb getestet werden.

Die Nichtbeachtung dieser Anweisungen kann Tod, schwere Verletzungen
oder Sachschäden zur Folge haben.

WARNUNG
NICHT BESTIMMUNGSGEMÄSSER GERÄTEBETRIEB
• Verwenden Sie mit diesem Gerät nur von Schneider Electric genehmigte

Software.
• Aktualisieren Sie Ihr Anwendungsprogramm jedes Mal, wenn Sie die

physische Hardwarekonfiguration ändern.
Die Nichtbeachtung dieser Anweisungen kann Tod, schwere Verletzungen
oder Sachschäden zur Folge haben.
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Vor der Inbetriebnahme
Verwenden Sie dieses Produkt nicht zusammen mit Maschinen, die mit keiner
effektiven Gefahrstellensicherung ausgestattet sind. Ohne eine effektive
Gefahrstellensicherung kann der Bediener der betreffenden Maschine schwere
Verletzungen davontragen.

WARNUNG
UNGESCHÜTZTE GERÄTE
• Verwenden Sie diese Software und zugehörige Automatisierungsgeräte

nicht zusammen mit Verpackungsgeräten, die über keine
Gefahrstellensicherung verfügen.

• Greifen Sie während des Betriebs nicht in die Maschinen hinein.
Die Nichtbeachtung dieser Anweisungen kann Tod, schwere Verletzungen
oder Sachschäden zur Folge haben.

Dieses Automatisierungsgerät und die zugehörige Software werden zur
Steuerung einer Vielzahl von Industrieverfahren verwendet. Welcher Typ bzw.
welches Modell eines Automatisierungsgeräts für eine spezifische Anwendung am
besten geeignet ist, hängt von verschiedenen Faktoren ab, wie z. B. von der
benötigten Steuerungsfunktion, der erforderlichen Schutzart, den
Produktionsmethoden, etwaigen ungewöhnlichen Bedingungen, gesetzlichen
Vorschriften usw. Für manche Anwendungen müssen eventuell mehrere
Prozessoren eingesetzt werden, beispielsweise wenn aus Sicherheitsgründen
eine Redundanz erforderlich ist.

Nur dem Benutzer sind sämtliche Bedingungen und Faktoren bekannt, die für die
Einrichtung, für den Betrieb und für die Wartung der Maschine eine Rolle spielen.
Aus diesem Grund ist allein der Bediener in der Lage zu bestimmen, welches
Automatisierungsgerät und welche zugehörigen Schutz- und Sperrvorrichtungen
ordnungsgemäß eingesetzt werden können. Bei der Auswahl der
Automatisierungs- und Steuerungsgeräte sowie der zugehörigen Software für
eine bestimmte Anwendung muss der Benutzer alle geltenden regionalen und
nationalen Normen und Vorschriften berücksichtigen. Das Accident Prevention
Manual (national anerkannt in den USA) enthält hierzu ebenfalls viele nützliche
Informationen.

Bei manchen Anwendungen, wie z. B. Verpackungsmaschinen, ist ein
zusätzlicher Schutz des Bedieners erforderlich, wie etwa in Form einer
Gefahrstellensicherung. Das ist notwendig, wenn die Hände bzw. andere
Körperteile des Bedieners eingeklemmt bzw. gequetscht werden könnten, sodass
schwere Verletzungen auftreten können. Softwareprodukte allein können den
Bediener nicht vor Verletzungen schützen. Aus diesem Grund darf die Software
auf keinen Fall als Ersatz für eine ordnungsgemäße Gefahrstellensicherung
betrachtet werden.

Stellen Sie sicher, dass angemessene Schutz- und Sperrmechanismen passend
zur Gefahrstellensicherung installiert wurden und funktionsfähig sind, bevor Sie
das Gerät in Betrieb nehmen. Alle Schutz- und Sperrvorrichtungen für die
Gefahrstellensicherung müssen auf das jeweilige Automatisierungsgerät und die
Softwareprogrammierung abgestimmt werden.

HINWEIS: Die Koordinierung der Schutzmechanismen und mechanischen/
elektrischen Sperrvorrichtungen für die Gefahrstellensicherung geht über den
Rahmen der Funktionsblockbibliothek, des Systembenutzerhandbuches oder
anderen Implementierungen, auf die in diesen Unterlagen verwiesen wird,
hinaus.
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Inbetriebnahme und Anlauftest
Bevor elektrische Steuerungs- und Automatisierungsgeräte nach ihrer Installation
im regulären Betrieb eingesetzt werden, muss das System zur Überprüfung der
einwandfreien Funktion einem Anlauftest unterzogen werden. Dieser Test muss
von qualifiziertem Personal durchgeführt werden. Um einen vollständigen und
erfolgreichen Test zu gewährleisten, ist es wichtig, dass entsprechende
Vorkehrungen getroffen und ausreichend Zeit für den Test eingeplant werden.

WARNUNG
GEFAHR BEI GERÄTEBETRIEB
• Überprüfen Sie, ob alle Installations- und Einrichtungsverfahren

abgeschlossen wurden.
• Entfernen Sie vor der Durchführung von Funktionstests alle Blöcke oder

sonstige Haltevorrichtungen, die vorübergehend für den Transport
angebracht wurden, von allen Gerätekomponenten.

• Entfernen Sie Werkzeuge, Messgeräte und jegliche Abfallteile vom Gerät.
Die Nichtbeachtung dieser Anweisungen kann Tod, schwere Verletzungen
oder Sachschäden zur Folge haben.

Führen Sie alle Inbetriebnahmetests durch, die in den Geräteunterlagen
empfohlen werden. Bewahren Sie alle Geräteunterlagen für eine zukünftige
Verwendung auf.

Softwaretests müssen sowohl in einer simulierten als auch in einer realen
Umgebung durchgeführt werden.

Überprüfen Sie, ob das gesamte System kurzschluss- und erdungsfrei ist – mit
Ausnahme der Erdungen, die gemäß den jeweils geltenden Vorschriften installiert
wurden (in den USA z. B. gemäß den Vorschriften des National Electrical Code).
Falls eine Hochspannungsprüfung erforderlich ist, halten Sie sich an die
Empfehlungen in den Geräteunterlagen, um versehentliche Geräteschäden zu
vermeiden.

Bevor Sie die Geräte unter Spannung setzen:
• Entfernen Sie Werkzeuge, Messgeräte und jegliche Abfallteile vom Gerät.
• Schließen Sie die Tür des Gerätegehäuses.
• Entfernen Sie die Erdung von Spannungsversorgungsleitungen.
• Führen Sie alle vom Hersteller empfohlenen Anlauftests durch.

Betrieb und Anpassungen
Die folgenden Vorsichtsmaßnahmen wurden der NEMA Standards Publication
ICS 7.1-1995 entnommen (die englische Fassung ist maßgebend):

• Unabhängig von der Sorgfalt, die bei der Entwicklung und Herstellung der
Geräte oder bei der Auswahl und Auslegung der Komponenten angewendet
wurde, können verschiedene Gefahren auftreten, wenn solche Geräte
unsachgemäß betrieben werden.

• Es ist mitunter möglich, dass Geräte fehlerhaft eingestellt werden, was zu
einem mangelhaften oder unsicheren Betrieb führt. Beachten Sie stets die
Anweisungen des Herstellers für funktionelle Anpassungen. Personen, die
Zugang zu diesen Anpassungen haben, müssen mit den Anweisungen des
Geräteherstellers sowie mit den Maschinen vertraut sein, die zusammen mit
den elektrischen Geräten eingesetzt werden.

• Der Bediener sollte ausschließlich auf die Betriebsanpassungen Zugang
haben, die für seine Tätigkeit erforderlich sind. Der Zugang zu anderen
Steuerungselementen muss eingeschränkt werden, um unbefugte
Änderungen an den Betriebseigenschaften zu verhindern.
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TeSys island – Einführung

TeSys-Master-Serie
TeSys ist eine innovative Motorsteuerungs- und Motormanagementlösung vom
globalen Marktführer. TeSys bietet vernetzte, effiziente Produkte und Lösungen
für Schaltungen und den Schutz von Motoren und elektrischen Lasten in
Übereinstimmung mit allen wichtigen weltweiten elektrotechnischen Normen.

Überblick
TeSys island bietet ein verbundenes und benutzerdefiniertes System für die
direkte Steuerung und das Management von Niederspannungslasten. Das Island
optimiert die Verfügbarkeit der physischen Module mit eingebetteten
Voralarmmanagement-Funktionen.

TeSys island ist für Leistungs- und Hochleistungsmaschinen mit
Automatisierungsarchitekturen vorgesehen, in denen Geräte über
Hochgeschwindigkeitsnetzwerke mit einer SPS verbunden werden. Bei
Maschinen, die mit hohen Produktionsraten arbeiten, müssen ungeplante
Produktionsausfallzeiten verhindert werden, da diese extrem kostspielig sein
können. Mit TeSys island können ungeplante Ausfallzeiten durch vorbeugende
Wartungsarbeiten verringert werden, da die Reparaturen in einem geplanten
Wartungsfenster abgeschlossen werden.

TeSys island wird mit digitalen Objekten vollständig in die SPS-
Programmierumgebung integriert. TeSys island kann vollumfänglich in das
EcoStruxure-Portfolio integriert werden, das Produkte und Softwarepakete zu
Automatisierungslösungen für OEMs und Maschinenbauer kombiniert. Das
System unterstützt auch die Integration in Drittanbieter-SPS-Optionen.

DOCA0236DE-00 11
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TeSys island-Konzept
TeSys island ist ein offenes, modulares und dezentrales Eingangs-/
Ausgangssystem, das verschiedene Module umfasst, die auf einer DIN-Schienen-
Rückwandplatine montiert sind.

A Buskoppler

B Analogein-/-ausgangsmodul

C Digitalein-/-ausgangsmodul

D Spannungsschnittstellenmodul

E Standard-Starter

F SIL-Starter (Sicherheitsanforderungsstufe)

G SIL-Schnittstellenmodul

H Leistungsschnittstellenmodul

Das TeSys island-Gerät fungiert als Knoten in einem Feldbusnetzwerk. Der
Buskoppler bildet das Kernmodul des Geräts. Der Buskoppler ermöglicht die
interne Kommunikation mit den TeSys island-Modulen über Flachbandkabel und
die externe Kommunikation über das Modbus TCP-Protokoll.

Weitere Informationen hierzu finden Sie in der TeSys island-Systemanleitung.

Systemanforderungen
Die folgenden Komponenten sind für die Kommunikation über EtherNet/IP oder
Modbus TCP erforderlich.

Komponente Typ und Version

EcoStruxure Control Expert Classic-Software Classic V15.0 SP1

PSx DTM-Bibliotheksversion 3.14.54

Schneider_Electric_TeSys_island_DTM_Library version 2.2.2 oder aktueller

Controller Logik-Controller BMEP58••••

12 DOCA0236DE-00
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Integration von TeSys island in ein EcoStruxure
Control Expert Classic-Projekt

Projekt erstellen
HINWEIS: Bevor Sie ein neues Projekt erstellen, müssen Sie wissen welche
Art von SPS-Modell und SPS-Rückwandplatine in das Projekt integriert
werden sollen.

Führen Sie die nachstehenden Schritte aus, um ein Projekt zu erstellen:

Schritt Maßnahme
1 Öffnen Sie die Software EcoStruxure Contol Expert Classic.

2 Klicken Sie auf File > New (Datei > Neu).

Ergebnis: Eine Liste der SPS-Optionen wird auf dem Bildschirm angezeigt.

3 Wählen Sie entsprechend der Hardware, die für das Projekt verwendet wird, eine SPS Modicon
M580 aus.

1. Klicken Sie im Fenster PLC (SPS) auf Modicon M580..
2. Erweitern Sie im Fenster Rack den Eintrag Modicon M580 local drop (Modicon M580 –

lokaler Abzweiger) und wählen Sie ein Rack aus..
3. Klicken Sie auf OK.

Ergebnis:
a. Es erscheint ein Befehlsverarbeitungsfenster. Warten Sie eine Weile, bis die Verarbeitung

der Konfigurationsdateien abgeschlossen ist.
b. Wenn die Verarbeitung der Dateien abgeschlossen ist, erscheint das Fenster Security

enforcement (Sicherheitserzwingung) auf dem Bildschirm.

DOCA0236DE-00 13
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Integration von TeSys island in ein EcoStruxure Control

Expert Classic-Projekt

Schritt Maßnahme

4 Um ein Kennwort zu verwalten, führen Sie je nach Bedarf einen der folgenden Schritte aus:
• Erstellen Sie für das Projekt ein neues Kennwort und klicken Sie auf OK.
• Klicken Sie auf Cancel (Abbrechen), falls kein Kennwort erforderlich ist.
Ergebnis: Die Projektstruktur wird erstellt und im Fenster Project Browser (Projekt-Browser)
angezeigt.
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Integration von TeSys island in ein EcoStruxure Control Expert
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Schritt Maßnahme
5 Doppelklicken Sie in der „Structural view“ (Strukturansicht) auf den Ordner Configuration

(Konfiguration).

Ergebnis: Die physische Ansicht der Gerätekonfiguration wird auf dem Bildschirm angezeigt.
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Expert Classic-Projekt

TeSys island zum Projekt hinzufügen
Führen Sie die nachstehenden Schritte aus, um das TeSys island zum Projekt
hinzuzufügen:

Schritt Maßnahme
1 Klicken Sie auf Tools > DTM Browser (Extras > DTM-Browser).

2 Rechtsklicken Sie im Fenster DTM Browser auf den CPU-Namen und wählen Sie Add
(Hinzufügen) aus.

Ergebnis: Das Fenster Add wird auf dem Bildschirm angezeigt.

3 Wählen Sie im Dropdown-Menü „Protocol“ (Protokoll) die Option Modbus over TCP (Modbus über
TCP) aus.
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Schritt Maßnahme
4 Wählen Sie das TeSys island-Gerät aus und klicken Sie auf Add DTM (DTM hinzufügen).

Ergebnis: Das Fenster mit den Geräteeigenschaften wird auf dem Bildschirm angezeigt.

5 Ändern Sie im Fenster Properties of device (Eigenschaften des Geräts) bei Bedarf den
Gerätenamen und klicken Sie auf OK.

DOCA0236DE-00 17



TeSys island – Digitale Motormanagement-Lösung
Integration von TeSys island in ein EcoStruxure Control

Expert Classic-Projekt

IP-Adresse der CPU konfigurieren
Führen Sie die nachstehenden Schritte aus, um die IP-Adresse der CPU zu
konfigurieren:

Schritt Maßnahme
1 Doppelklicken Sie im Fenster Project Browser (Projekt-Browser) auf den Ordner Configuration

(Konfiguration).

Ergebnis: Die physische Ansicht der Gerätekonfiguration wird auf dem Bildschirm angezeigt.

2 Doppelklicken Sie im Fenster PLC bus (SPS-Bus) auf die Kommunikationsanschlüsse der SPS.

Ergebnis: Das Fenster mit den Kommunikationseinstellungen der SPS wird auf dem Bildschirm
angezeigt.

3 Klicken Sie auf das Menü Security (Sicherheit) und führen Sie je nach Bedarf einen der folgenden
Schritte aus:

• Klicken Sie auf Enforce Security (Sicherheit erzwingen), um die Dienste zu aktivieren bzw. zu
deaktivieren.

• Klicken Sie auf Unlock Security (Sicherheit entsperren), um alle Dienste zu aktivieren.
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Schritt Maßnahme
4 Klicken Sie auf das Menü IP Configuration (IP-Konfiguration) und stellen Sie die IP-Adresse der

CPU gemäß dem Netzwerk ein.

Hinweis: Der Wert für IP address A (IP-Adresse A) muss sich vom Wert für Main IP address (IP-
Hauptadresse) unterscheiden.

5
Klicken Sie auf der Symbolleiste auf das Validieren-Symbol ( ).
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Integration von TeSys island in ein EcoStruxure Control

Expert Classic-Projekt

IP-Adresse des TeSys island konfigurieren
Führen Sie die nachstehenden Schritte aus, um die IP-Adresse des TeSys island
zu konfigurieren:

Schritt Maßnahme
1 Doppelklicken Sie im Fenster DTM Browser (DTM-Browser) auf die CPU.

Ergebnis: Das Fenster Gerätekonfiguration wird auf dem Bildschirm angezeigt.

2 Wählen Sie das Menü TeSys island device > Address Setting (TeSys island-Gerät >
Adresseinstellung) aus und konfigurieren Sie die IP-Adresse des TeSys island.

3 Klicken Sie auf Apply (Übernehmen).

4

Klicken Sie auf der Symbolleiste auf das Erstellen-Symbol ( ).
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TeSys island-Projekt in SPS hochladen
Führen Sie die nachstehenden Schritte aus, um das TeSys island-Projekt in die
SPS hochzuladen:

Schri-
tt

Maßnahme

1 Stellen Sie eine Verbindung zwischen dem PC und der SPS her, indem Sie einen der folgenden
Schritte ausführen:

• Stellen Sie über die IP-Adresse eine Verbindung zur SPS her.

• Schließen Sie das USB-Erdungskabel (BMXXCAUSBH018) am PC und am Front-Bedienfeld der
SPS M580 an.

2
Klicken Sie auf der Symbolleiste auf das Verbinden-Symbol ( ).
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Expert Classic-Projekt

Schri-
tt

Maßnahme

3
Klicken Sie auf der Symbolleiste auf das Herunterladen-Symbol ( ).

Ergebnis: Das Fenster Transfer Project to PLC (Projekt in SPS übertragen) wird auf dem Bildschirm
angezeigt.

4 Klicken Sie auf Transfer (Übertragen).

Ergebnis: Das TeSys island-Projekt wird in die SPS hochgeladen.

5 Doppelklicken Sie im Fenster DTM Browser (DTM-Browser) auf die CPU.

Ergebnis: Das Kommunikationsfenster wird auf dem Bildschirm angezeigt.

6 Wählen Sie Channel Properties > IPAddress Source (PC) (Kanaleigenschaften > IP-Adressquelle
[PC]) aus und klicken Sie auf OK.

7 Rechtsklicken Sie im Fenster DTM Browser auf den CPU-Namen und wählen Sie Connect
(Verbinden) aus.
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Schri-
tt

Maßnahme

8 Rechtsklicken Sie im Fenster DTM Browser auf das TeSys island-Gerät und wählen Sie Connect
aus.

9 Sie können gemäß Ihren spezifischen Anforderungen einen der folgenden Schritte auswählen, um
das TeSys island zu konfigurieren:

• Wenn das TeSys island bereits konfiguriert wurde und der Benutzer keine neue Konfiguration
hochladen möchte, rechtsklicken Sie im Fenster DTM Browser auf das TeSys island-Gerät und
wählen Sie Load data from device (Daten von Gerät laden) aus.

• Wenn das TeSys island noch nicht konfiguriert wurde und der Benutzer eine neue Konfiguration
hochladen möchte, führen Sie nach Bedarf eine der folgenden Maßnahmen aus:
◦ Doppelklicken Sie im Fenster DTM Browser auf das TeSys island-Gerät und konfigurieren Sie

das Gerät.

◦ Rechtsklicken Sie im Fenster DTM Browser auf das TeSys island-Gerät und klicken Sie auf
Device menu > Additional functions > Import > Import TeSys island Configurator
Format (Gerätemenü > Zusätzliche Funktionen > Importieren > TeSys island-Konfigurator-
Format importieren), um die Konfigurationsdateien zu importieren.
Ergebnis: Die neue Konfiguration wird in die Software importiert.
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Expert Classic-Projekt

Schri-
tt

Maßnahme

10 Doppelklicken Sie im Fenster DTM Browser auf das TeSys island-Gerät und wählen Sie Store data
to device (Daten auf Gerät speichern) aus.
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TeSys island-Projekt über ein Ethernet-Kabel in die SPS
hochladen

Führen Sie die nachstehenden Schritte aus, um das TeSys island-Projekt über ein
Ethernet-Kabel in die SPS hochzuladen:

Schritt Maßnahme
1 Klicken Sie auf PLC > Set Address (SPS > Adresse einstellen).

Ergebnis: Das Fenster Set Address wird auf dem Bildschirm angezeigt.

2 Wählen Sie die IP-Adresse der SPS aus. Wählen Sie Media (Medien) als TCPIP (TCP/IP-Adresse)
aus und klicken Sie auf OK.

3
Klicken Sie auf der Symbolleiste auf das Verbinden-Symbol ( ).

Ergebnis: TeSys island wird in das Projekt integriert und mit der SPS Modicon M580 in der
Software EcoStruxure Control Expert Classic verbunden.
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verwenden

TeSys island-Bibliothek für die
Anwendungsentwicklung verwenden

Überblick
Die TeSys island-Bibliothek wird zum Types Library Manager (Typenbibliothek-
Manager) in der Software EcoStruxure Control Expert Classic hinzugefügt. Der
Bibliothek-Manager stellt Funktionsblöcke zur Unterstützung der
Anwendungsentwicklung und zur Steuerung von TeSys-Avatars zur Verfügung.

Funktionsblöcke der TeSys island-Bibliothek installieren
Führen Sie die nachstehenden Schritte aus, um die Funktionsblöcke der TeSys
island-Bibliothek zu installieren:

Schritt Maßnahme
1 Laden Sie die aktuelle ZIP-Datei „EcoStruxure Control Expert 2021 – TeSys island Library“ vom

Schneider Electric Industry End Users and SI Campus herunter.

2 Entpacken Sie die ZIP-Datei auf der lokalen Festplatte.

3 Klicken Sie auf Start > EcoStruxure Control Expert Classic > Types library update
(Typenbibliothek-Aktualisierung).

Ergebnis: Das Fenster Types library update wird auf dem Bildschirm angezeigt.

4 Klicken Sie auf die Schaltfläche „Browse“ (Durchsuchen).

5 Navigieren Sie zum Speicherort des entpackten ZIP-Ordners, wählen Sie die Datei FAMILY.DSC
aus und klicken Sie auf Open (Öffnen).
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Schritt Maßnahme
6 Klicken Sie auf Install family (Familie installieren).

Ergebnis: Die Installation der Bibliotheksdatei wird gestartet.

7 Nach der erfolgreichen Installation einer Familiendatei erscheint eine entsprechende Nachricht auf
dem Bildschirm. Klicken Sie auf OK.

8 Öffnen Sie die Software EcoStruxure Control Expert Classic. Klicken Sie auf Tools > Types
Library Manager (Extras > Typenbibliothek-Manager).

Ergebnis: TeSys island Library 2021 wird unter Libset V15.0 oder aktueller angezeigt.
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Projekteinstellungen konfigurieren
Führen Sie die nachstehenden Schritte aus, um die Projekteinstellungen zu
konfigurieren:

Schritt Maßnahme
1 Öffnen Sie die generierte STU- oder XREF-Datei in der EcoStruxure Control Expert Classic-

Software.

2 Klicken Sie auf Tools > Project Settings (Extras > Projekteinstellungen).

Ergebnis: Das Fenster Project Settings wird auf dem Bildschirm angezeigt.

3 Klicken Sie auf Variables (Variablen) und markieren Sie das Kontrollkästchen Allow dynamic
arrays (ANY_ARRAY_XXX) (Dynamische Arrays zulassen), damit der erkannte Fehler E1208
usage of dynamic arrays is disabled (E1208 Nutzung der dynamischen Arrays ist deaktiviert) bei
der Kompilierung des Projekts nicht gemeldet wird.

4 Entfernen Sie die Markierung des Kontrollkästchens Force references initialization
(Referenzeninitialisierung erzwingen).

5 Klicken Sie auf Languages > Common (Sprachen > Allgemein) und markieren Sie das
Kontrollkästchen Allow multi assignment [a=b=c] {ST/LD} (Mehrfachzuweisung zulassen), damit
der erkannte Fehler E1203 usage of multi assignment statements is disabled (E1203 Nutzung
der Mehrfachzuweisungshinweise ist deaktiviert) bei der Kompilierung des Projekts nicht gemeldet
wird.
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Funktionsblöcke für die Anwendungsentwicklung verwenden
Führen Sie die nachstehenden Schritte aus, um den Funktionsblock für die
Anwendungsentwicklung in der EcoStruxure Control Expert Classic-Software
einzusetzen:

Schritt Maßnahme
1 Klicken Sie im Fenster Project Browser (Projekt-Browser) auf Programs >Tasks > MAST > Logic

(Programme > Aufgaben > MAST > Logik).

2 Rechtsklicken Sie auf den Ordner Logic (Logik) und wählen Sie New Section (Neuer Abschnitt)
aus.

Ergebnis: Das Fenster New Section wird auf dem Bildschirm angezeigt.

3 Geben Sie einen neuen Namen für den Funktionsblock ein. Wählen Sie unter „Language“ (Sprache)
FBD aus und klicken Sie auf OK.

Ergebnis: Die Konfigurationszone wird auf dem Bildschirm angezeigt.
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Schritt Maßnahme
4 Rechtsklicken Sie auf die Konfigurationszone und wählen Sie FFB Input Assistant (FFB-

Eingabeassistent) aus.

Ergebnis: Das Fenster Function Input Assistant (Funktionseingabeassistent) wird auf dem
Bildschirm angezeigt.

5 Klicken Sie oben rechts auf dem Bildschirm Function Input Assistant auf die Durchsuchen-
Schaltfläche.

Ergebnis: Das Fenster FFB Type Selection (FFB-Typ-Auswahl) wird auf dem Bildschirm
angezeigt.

6 Wählen Sie auf dem Bildschirm FFB Type Selection die Option <Libset V15.0> > TeSys island
Library 2021 (TeSys island-Bibliothek 2021) aus und dann den erforderlichen Funktionsblock.
Klicken Sie anschließend auf OK.
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Schritt Maßnahme
7 Nachdem Sie den Funktionsblock ausgewählt haben, klicken Sie auf dem Bildschirm Function

Input Assistant auf OK.

Ergebnis: In der Nähe des Mauszeigers erscheint ein Symbol.

8 Linksklicken Sie auf die Konfigurationszone.

Ergebnis: Die Strukturansicht des Funktionsblocks wird auf dem Bildschirm angezeigt.

Weitere Informationen zu den verfügbaren Funktionsblöcken und ihrer
Konfiguration finden Sie im EcoStruxure Control Expert – TeSys island Library
Control – User Guide (EcoStruxure Control Expert – TeSys island-
Bibliothekssteuerung – Benutzerhandbuch).
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